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Revision History

1.1

The revision history describes the changes that were implemented in the document. The changes are
listed by revision, starting with the most current publication.

Revision 1.0

Revision 1.0 is the first publication of this document.
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Introduction

Synopsys ldentify ME is an RTL debugger that allows you to probe internal signals of the design directly
from the programmed FPGA in the original RTL code or in a waveform viewer.

Identify consists of two separate tools: instrumentor and debugger. The instrumentor compiles and
inserts the required logic into the original RTL to create an instrumented design that allows probing of
internal signals. The debugger communicates to the FlashPro, FlashPro Lite, and FlashPro3/4/5
programmer through JTAG to get the probed signal values.

This tutorial describes how to use Identify ME instrumentor and debugger within Libero® System-on-
Chip (SoC) flow. It also describes how Identify instrumentor works with Synplify Pro.

Identify Flow

The following diagram shows the debug flow with Identify. Before synthesis, the RTL design is
instrumented using the Identify ME instrumentor. Instrumentation is a process of creating instrumented
HDL sources that can be used to debug the design in the Identify ME debugger.

The instrumentor allows you to:

1. Setthe sample signals
2. Trigger points for conditional sampling
3. Watchpoints for allowing specific event-driven sampling of the signals within the design

Once this is done, the Identify ME debugger communicates with the instrumented source and captures
the operation of the device through the flash device programmer. The sampled signal values can be
viewed directly in the RTL or on a waveform viewer.

Identify Flow Diagram

Identify Flow

Design Creation i ==

|

Identify Instrumentation [ -
Synthesis -

l

Place and Route

l

Programming

Flash Device Programming <4—» Identify Debugger - A T
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TUO0780 Tutorial Revision 1.0 2



Using Identify ME with Libero SoC O M. .
Iicrosemi

Power Matters.”

3 Using Identify ME with Libero SoC

3.1 Step 1: Create a Libero SoC Project

1. Download and install Libero SoC v11.8 on the host PC.
2. Start Libero SoC v11.8, and in the Project menu, click New Project or click New from the start page
as shown in the following figure.

Figure 2« Libero Start Page

Project File Edit View Design Tools Help
e 4 o i

D2 aXx@od |

StartPage ¥

‘_

Welcome to Microsemi's Libero® SoC v11.8 L

Recent Projects

C:/libero/example d.../...olarFireFabric
C:/libero/example d.../G5

Microsemi Libero® System-on-Chip (SoC) design suite offers high productivity with its comprehensive,
easy to learn, easy to adopt development tools for designing with Microsemi's power efficient flash
FPGAs, SoC FPGAs, and Rad-Tolerant FPGAs. The suite integrates industry standard Synopsys

. Synplify Pro® synthesis and Mentor Graphics ModelSim® simulation with best-in-class constraints
Welcome £ Libero SoC = management, debug capabilities, and secure production programming support.

Libero SoC Quickstart L
Libero SoC Interface Description What's New in Libero SoC v11.8

Libero So0C Release Notes on the Web

The Libero SoC v11 8 release includes the following features and enhancements:
Libero Tutorials

- = New Libero License Options 52

Message g X

0 Errors  _§, Warnings o Info E]Managa suppressed messages

Log Message

I Fam: |Part:
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Using Identify ME with Libero SoC

The New project window is displayed as shown in the following figure.

Figure 3« Libero New Project
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r —
@ New project T EE
Project details
Specify praject details
(| Project Details
Project name:
Praoject location: F:/Wark/svn/G5/EAP4/Dema/MNew Folder -_Erowse. -
Device Selection
Description:
i Device Settings /
I
L
Deslgn Tem plate Preferred HOL type:
" [] Enable block creation
Add HDL Sources
i
Add Constraints i
||
I
Libefo) |
Systemon-Chip ~
< Back Next = Finish

3. Select the project settings and click Finish to create a new project.
4. From the Projects menu, click Tool Profiles and select Synplify Pro (for Libero SoC Platinum

customers) as the synthesis tool.
Figure 4« Tool Profiles

Programming Synplify Pro ME

e &
Identify Debugger
b o

F:\synplifyPra\bin\synplify_pro.exe
Yidmtechpub_all\transfer\4_ambika

GSW_patchbin\synplify_pro.exe

@ Tool Profiles - —— m
4 Tools
Synthesis Synthesis profiles E]
Simulati
pmuaen Active Name Path
Stimulus

\synplify_L201609M-

[Emort Profiles.. l [

OK l [ Cancel

TUO0780 Tutorial Revision 1.0



Using Identify ME with Libero SoC O M. .
IViicrosemi.

3.2

Figure 5«

Power Matters.”

Step 2: Create an Identify Implementation

1. After running synthesis with the non-instrumented design in Synplify Pro, create an Identify
implementation.

2. Inthe SynplifyPro window, from the Options menu click Configure Identify Launch as shown in
the following figure.

Configure Identify Launch in Synplify Pro

Configuer VHIL Compiler () New HOL Analyst (Beta)
Configune Viarilog Compiler
. Project Status | Imglomaetation Diectory | Process View
Editar Options ) : )
P&R Emvironment Optkons. o |
Project Status Page Location... Progect Name Implementation Name
HOL Analyst Oplions...
Status. (CPU Tima Raal Tima Momory  DatelTima
out-of-date
out-of date
out-of-date
B
(]
run_tel -£7 LED Toggle RTL sym.tel [
Implementation not found: synthesis -
ICL script complete: 'Ltﬂ_fmle_nf!._!\ﬂ\.ttl' -
o -
TCL Scrpt | Messages
Sel up Io lsurch Idenkily Instrumentor ) =, £8 3

3. Select the location to install the Identify debugger as shown in the following figure.

Figure 6 « Identify Instrumentor Set to Integrated Mode
5 Symplty Pro L-201S09M2 - [S:Meribty UG symthesis/LED,_Toggle BT syr il “
h_;;mmmmm;mrmmmm - =18
BeOde@s 0ol eDom @O [ New HDL Analyst (Beta)

Continug on Enoe [=] [C-MicrosemilLibern_SoC_v11.Budsntily]
FSM Compiler |

FSM Explonr |[=] Ideniify License Oplion

Resource Sharing 4

Rotiming =] Use cument synithesis license

Tun_tel -f£§ LED Toggle RTL synm.tel
TCL script cemplete: =LED Toggle RTL_sym.tol~

| Design Herarchy
Wcroscmi SmariFusion? | M25025 : FBGASE | 5T0
@ [LED_Toggle_RTL_syn] - S-udently_UGisynthesis\LED_Togghe_f
g Venlog [Project Hame Implementation Name

(1] E Logic Conatraints (FDC)
Eynihesis

® LUse separste Identify license

R EE

TCLScripl | Mesaages |
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Right-click on the existing synthesis implementation and select New Identify Implementation as

shown in the following figure.

Figure 7«  Select New Identify Instrumentor

'_n_-:: Fils v\u Project Run HOL-Analyst Opfions Window Wab Halp
Bd4O0DEd S 0 Fane B0 0w @EM [ Mew HOL Analysi (Beta)
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syrandals Imphamentation Options... [ |
Change Implamentation Name... LJob Name Status D [CPU Time  Real Time: Memory (Ti
Higsarchical Project Options, Comgale Input out-of-date.
A Sut-Project Imples [Fre-mapping oul-ol-date
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Continue on Eror ] B Identify Instrumentor
FSM Compiler 1] M Launch igentity Dabugaer
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Rutiming ] Ol Add Place & Route D
Run FB
B LED_Toggle_RTL_synpq | Project View Optics...
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L . 3
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1l = K8 = 3
SynplifyPro creates the new implementation at default location:
<Libero_Project_Location>\synthesis\synthesis_1 as shown in the following figure.
Figure 8« Identify Implementation under Synthesis Folder.
5 Synplty Pro L-2006.09M-2 - [S<dentity UG/synthesis/LED Toggle RTL syn.pil n E__alEI = |
=]

Fie Emt View Progect Run Analysis HDU-Analyst Oplions  Window Wb Heip
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Ready
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| - MZBOZS ; FBGANSA - STD

= éLED_W'I"L _sym] - S:ldenily UGisynthesisLED_Toggle |
B

D &
B eE®E@ %

9Run

Project Status | Implementation Direclory | Process View |

Device | Options | Consirainls | Implementation Resuls | Timing Reporl | Vidlog | Place and Route | Mplementations:
T —
Implementation Name-

) Now HDL Analyst (Bita)

syrihasis_1

Resuis Direciory:

| Suidentity_UG\synthesisisynthasis_1

Pesult Base Name:
[LED_Toggle RTL

ESM Compier
FSM Explorer
Risourcs Shanng
Retiming

D=o=Eg

5]
(B LED_Togge RTL_syn.pd

Opticnal Output Fils Opticns
[ Wirite Mapped Vierlog Netiist
|| Wirite Mapped VHEL Netiist
[ Wit Viendor Constraint Fil

TICENAT OPCUN . WL UeL_ U

run_tel -£g LED_Toggle_RTL_syn.tel
TCL seripr compleve: "LED_Toggle_RTL_sym.m

L]
TCLScrpt | Messages |

Note:
Results Directory path as shown in the preceding figure.

Note:
Libero to pick the correct identify instrumented synthesis netlist.

EEEE Bl

You can edit Implementation Name in the Implementation Results tab. Must not change the defined

The Identify implementation folder must be under synthesis folder of Libero project. This is required for
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3.3 Step 3: Launch Identify Instrumentor

1. After creating a new Identify implementation, right-click on synthesis_1 and select Identify
Instrumentor as shown in the following figure.

Figure 9« Launching Identify Instrumentor

B"meummmmmmwmmm
RN R IE BApe e RBE ¢S ewm @Em 1] ok HOL Anadyst (fita)

o J e —

WSS | FOGARS {510 ]
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: E Logic Constraints (FOG) e R
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[Job Name Status | [€B[CPUThme  [Real Time  Memory  |DatelTime
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sechical Project Options T TR
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|Rescurce Shanng =} HITL Wit
!Mlmw (=] 0| Tecrnclogy, View oo
- Add Place & Route |

Run FB

1B LED_Toggte_RTL_aynpn - |

run_tel =fg LED Toggle RTL_syn.tel
TEL seript complete: "LED 'rauu!— RTL_myn.tel®

inpl -add 8:/Tdentify UG aynthesin/synthenis_ 1 synthesis

[\

TCL Script | Massages
Il

2. Click Ok in the SRS Instrumentation dialog box.
Figure 10+ SRS Instrumentation

’ SRS Instrumentation - @u

Note: You can perform SRS instrumentation from an Analyst RTL view

SRS Instrumentation Options
B

Notify me when SRS instrumentation is possible
Automatically launch Analyst when SRS instrumentation is possible
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Identify Instrumentor is integrated with SynplifyPro and is launched as shown in the following figure.

Figure 11« Launching ldentify Instrumentor

< Synplify Pro L-2016.00M-2 - [RTL Instrumentor - Sldentify_UG\synthesis\synthesis_L\identify.id] (== &
&k [ File Edit View Project Run Analysis HDL-Analyst Instrumentor Options Windew Web Help [= )& %
B 48 O@ @ K B (| g @ 0 (B & |8 8 @ s | [_] New HDL Analyst {Beta)
$ 2O e Eger
RTL (LED_Toggle.v’ 1
Control Panel | Search (LED_Toggle.v) Instrumentation
T SmartFusion2 g i <Revision number>: <Daste>: <Comments> [4]
Communication Interface builtin 10/// Description
1
ICE 12/ <Description here>
13/, i
[nce ~ 14 ;7 eted device: <Family::SmartFusicn2> <Di
16, - <Namew
IICE Type FPGA Memory 16 /
Sample Clock =<Specify> 18 *timescale 1ns / 100ps
y 19
Sample Only Bits o 20 module LED Toggle RTL{ ¢f clk, dfzstn, &focut_ld
Trigger Only Bits ] 21
22 input & clk, & rstn;
Sample & Trigger Bits| 0 23 cutput [1:0] &fout_led, &fcut_lsb;
24
25 reg [24:01 & cnz;
26
27 zlways @lposedge & clk)
28 begin
if (~df zstm)
< 30 & cnt <= 25'd0; -
Instrumentations 31 else
@ 32 &f cnt <= & cnt + 1; o
Select:
v synthesis_1 - @
P LED_Toggle RTL_syn.pr * | ## RTL Instrumentor - identify.idc
Information =1
[0 warnings, D notes ] Find: [ - |5et Filter. . | [_| Apply Filter [ | Status Page Filter Group Common IDs
[Type [io | message | source Location Log Location | Time | Report

3.4 Step 4: Instrument the Design

1. You can instrument the design in Identify Instrumentor by selecting a sample clock and sample
trigger signals.
Note: In the Identify Instrumentor window, the signals available for instrumentation will have an icon in front of
it as shown in the following figure. To choose the sample clock, right-click on the signal name and select
Sample Clock. In the same way, select sample and trigger signals.

TUO0780 Tutorial Revision 1.0 9
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Figure 12 « Instrumentation with Identify Instrumentor
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REEREBERNBHEIRNESEIGE RO S0

-
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Select: E I
=
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ol EE
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| 7igmals edd -iice (IICE) -zample -vrigger {/ous_lskl
| feuz_izk added for sampling and triggesing Te iice: 1ICE
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a0

{ Inazrumencary

I LED_ Toggle ATL synpq * | [ RTL instrumentor - inentify o™

|0 veamings, 0 notes | Fana | - [sum ]ljwm ] Status Page Filter ) Group Commen IDs
IType [ [ Measoge [Souwrce Locaton | LogLocation[Time | Report ]
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I = 'S =
2. From the File menu, select Save Project Instrumentation to save and instrument the design.
3. Close the Instrumentor and run the final synthesis in Synplify Pro as shown in the following figure.
Figure 13+ Running Final Synthesis on Instrumented Design

B i P View Progct Run Analysis HDL-Analyst Options Window Web Help =iEx
PO Ded@s [ BAdeeeE@lYeSawm®Em | M HDL Ariatyst (Bota)
sCancel %Efff!_‘_‘_"
LED__‘N:WQ__R‘I‘I,_;W\;MJ: Mapping .. SHamrch Sotviet
|55 Gpon Projoct. || PromctFues | pesignseancry | ProisctStsun | impueaccaon DVeclory | Focess vie. |
e
B Cose prject 5 8 LED Toogle RTL_ayn] - Sildertly_UaynibesisLED,Togoie || (G et SeRga |
i Add File... Praject Naime LED_Toggle_RTL_syn Implementation Nane syrthesis_1
8y Change Fie. 4 i Top Module [0l Retining 0
Imglemertation. ynirdsis Rescarce Shaing 1 Fanout Guida 10000
.o - 1 (Mapping. .} Dnsable 1D Insertion [] i []
Impiemantation Options.
BR Add FER implementation
|A View Log Status Tima Time  |Memory
- Frogquoncy (MHz |- I i A9RNT
[0 5 Ao Const Compar: 2% e ALY
S = AT
’_‘5"'5"‘““""‘:"" &l Compiste 00m s bileninld]
F5M Explony; il | Compwes [18]0 |0 |- oomats 3 Ygone
Fatmnd = Completa 4 o |omoos omods Mg | H8201
Running
IERCIH
tompias: 23t u
4l ] ILHI
el
P LED Togghe ATL_synpy | 6 RETL Instnumerncs - ety ide
[#wamings. 30 nons ' Find: | =[50t Finoc, | ) Apply Filler [ Status Page Fiter | ) Group Comeon 1Ds
| Type I | Mensage |Sowce Location  [Log Location [Time | Report -
& ] MT53]  Found infamed clock jtag_intertace_xfh nv o0 Eym_gics.y LED_Toggie_... 145531  Pr-mapping Report L
ONZZS Wit defilt gropesty annctstion Tile S-lidantll... - LED Togge | 14:58:30
MF2E Rurveng in 64-08 mode, LED Topge . 148830 Pre-mapping Report -
MFESS  Inuert Iganksty debug cone LED Togole__ 14523 5
TN | Messages
] = a8 =

4. Synplify Pro maps the design into logic gates.
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3.5 Step 5: Change the Implementation View (Optional)

You can change the implementation view in Synplify Pro directly by clicking on the implementation.
Synplify Pro allows multiple implementation views at the same time.

3.6 Step 6: Launch and View the New Implementation
(Optional)

You can re-launch Identify from Synplify Pro by right-clicking on Identify implementation and selecting
Launch Identify from the list as shown in the following figure.

Figure 14+ Re-Launching Identify in Synplify Pro
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[ Acd File... £ Verllog Projact Nama | LED_Te RTL, M thi 1
5 ) Logc Comstraints (FDC) ProjectMame | LED Toggle RTL syn | ame synthesis_1
1
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Rusource Sharing 11 |Fanut Guide | 10000
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4R Add PAR Implemantation P ol Pre "
L i 2 = anarzon
»[100 & Auto Canal. | Copy Implementation. - 3409 PM
Continua on Ermor | 1dontity irglementation Camplets 00m 075 Ansion
FSM Compilee I 63 Identity Instrumantor =t
FSM Exploner o " n 482017
B Launcn ientty Deougger ca glo o om0
Resource Shanng & D e i o118 28832 P0
Raten 7
" | Tachnclogy View Compiate [ 124 |0 | omeoos Do 045 Mg |40y
[Aas e & o a7
| = Compiote [ 23]22]0 |omots tm 035 1aMe | s
| Prqmmoum
Compite e
u'i = 1 [} 5P Blocks (MACC) {dsp_vsed) [0 |vocens e | if
= o - e | r—— - L. 1L

1) LED_Toggle RTL_synpr |

B

(26 wamings, 53 netes = |50t Futec | 1) Apply Fiter || Status Pags Filter | [¥] Group Commen I0s

hpe | [uessice [souree ocaven | Repon l11

[i] a MIs20 Found infemsa clock [Eag_intorace s mv_od) LED Toooie .. * 3 Clotk Comversion L
BNA0T  MisSing syn_Pyper ST with I L410g WIpp. . 1 Pro-mapping Repat

4 MISI0 Found infamsd clock [tag_interdace xpd_nv o0, . & 5 Privmapping Report =

i § a8 MOIED Wmumw an]mvmmvn M__ hoded u mmw -

TELECp | Messages

I - £2 =3

3.7 Step 7: Organize Instrumented EDIF in Libero SoC

1. The Libero SoC tool automatically selects the *.edn netlist from the Identify implementation folder
(synthesis_1) and you can run Compile and Place and Route for it.

2. Alternatively, if you have multiple netlist in the design, they can be organized as shown in the
following figure.
In the Libero Design Flow window, right-click on Compile and select Organize input files and
Organize Source files.

TUO0780 Tutorial Revision 1.0 11
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Figure 15« Importing .EDN File in Libero SoC

1| Organize Source files of test for Compile tool

)

Click to select a Source file in the project, and use the Add button to pass the file to the tool.
Use the Remove button to remove Source files.

Use the Up/Down arrow buttons to specify the order of the Source files when they're passed to the tool.

Use list of files organized by
@) Libero (default list)

) User * +
Source files in the project Qrigin Associated Source files Qrigin
1 test.edn User (synthesis_3) 1 test.edn User (test_12)
2 testedn User (synthesis)
Add +
+ Remove

OK } [ Cancel

As shown in the preceding figure, you can check/add an instrumented * . edn file.

3. After assigning/checking the input file, you can generate the programming file by clicking the

Generate programming file.
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Figure 16
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¥ Debug Design

B Ldentify Debug Design

€ SmatDebug Deugn
Handafi Design for Prodhstion
& Export Bititream
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#] Expost Job Manager Dsta
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Using Identify ME with Libero SoC

90 Progeamming Connectivity snd Interface

Bl Devce 10 Stabes Dunng Programeming - MT..

Do F
(Eesams) @ wores @
The ‘close_project” command succeeded.

The Execute 3cripc command succeeded.
Seacting Tdentify Debugger...

| Desgnvearsr. | somuucisecsr. | Cotakog | Ples ||

& Microsemi

Program the part by running Programming action as shown in the following figure.
Place and Route, Generate Programming, and Run Program Action

Power Matters.”

Exparzed lﬂa ll\f Se\Tdencify UG\deaigner\LED Toggle RTIALED Togyle RTL_fp\LED Togyle RIL.1sg.

|| hepots &% | Batiee @ % | Eup 8% | =
4 Preject Sumenary ([5TA) @ ones 4, 2wamng: @ oike
Idnntity UG log -
# LED Toggle RTL reports Software Versisn: 11.8.0.2¢
. tiTe 0 build 1
: FlashProd
nt\.t:i\?::‘l“.m G\ designer\LFD Tagyle RILALED Toggle RTL_SpALED Tagyle RTL.pro’
LED_ Togale RTL camp... The 'cpes_project' command succeeded,
o priin IFD file 'Si/ldentify USsaesignecsLED Togale KIL/LED mnn_m Apd* b been losded successfully.
LED Toggle RTL.camp... | pegsq ; LED Togple RIL: CHECKSOM : ZELF: 70B_VERSION :
b LED Toggle ATLz.. et _file' cosmand
4 Place and foute is alr
LED_ Toqqle RTL_gib_n_ || The 'essble_device' coemand
LED Toqgle RTL pinept_ || TH® 'u;;w:u—au saszion! mn: rarﬂ!drd
LED Togyle FTL pinepe | P277ammer "0 N SRR o e
LED_Togghe ATL bankr.. prwn—k Y Cneck Cha
LED_Teagle RTLoftl || oo oramper + Scan uad Check Chedn FASSED.
O LED Toqgle ATL I, || prograsmes fevice 'M22025Y : Bxecuring scticn PROGRAM
LED_Teggle RTL pls programmer * @ device EXPORT 15T ENABLE RESULT[32] = DOT34E44
4 Generate FPGA Brray Date || pEagrasses = device EXFORT CRIERRIL] = O
LED Toggle RTL init ¢ || Preqeasses : device FXPORT !mllm -0
+ Genarity Buuesm prograsssr * device TEMPGRADE:
LED_Togaie KTL gener... prograsmer device EXFORT \'Pm!»![l] -2
= At prograsser ' i device VEPRANSE: HIGH
ARLTRCRAM Aclith progresser ¢ * device EXPCRI TEMFI2] = €6
b LED Toggle RTLP- || prograssec + device EXPCRT VIT[E] - 73
- M . : device * Frograsmiag FEGA ATTay...
4 tap prograzmer device
topFCCE D configurs.. || ProdEasmer EXPIRT DSN[128] = 08c4an0i0000c4540023000100042020
top_manifeston FEOgrasmeT
2 pregrasser Finighed: Wed Zpr 15 15: 26 o4 -‘ﬂl? (Elapsed cime 00:00:3%)
prograsmer Executing acticn
prograsmer 0 pin progresming FASSED.
Chatn Prograssing PIJ\I&M‘Q Wed Rps 19 15:28:04 2017 (Elapaed tise 00:00:3%)
The ‘run_selected sctisns’ comsand succeeded.
The 'sec file' command
Froject saved.
Ine 'seve_project' commend succeeded,
Preject closed.
) L} '
- B
E |

| Loy [ massage |
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Figure 17 »

& Lbern

Step 8: Launch ldentify Debugger

& Microsemi

Power Matters.”

1. After programming the device with the instrumented design, you can invoke the Identify Debugger
through the Libero Design Flow.
2. Click Identify Debug Design and click Edit Profiles as shown in the following figure.

Set Identify Debugger Profile within Libero

. &m»,_um-di.-‘uﬁg'-p'

(Mmool &

Desn P

esan Flow
LED: Toggke RTL ]

Toal

B3 Create Sl iagn
M create HOL
i Creste SmanDesign Testbench
W) create HOL Testhench
o) Genarate Mamnry Map
4 b Vesify Pre-Synthesized Design
W smutate
P Conatraimts
B Manage Conptramy
b Implement Design
B Herlist Viewes
T Spothesiee
= b Vesily Past-Synthesis Imph

x| fpots S% | Seee ax | B ax

[+ Praject Summary
Idertity LGilog
4 LED Togghe RTL reports
o ymthesize
A LED Teggle RTLsir

D@@‘_

LED_Taggie KTL comp...
LED_Togghe RTL_comp._.
A LED Toggle RTL c..
4 Piace and Route
LED_Tagaie RTL_glb_n..
LED Togghe RTL pinept...

Date. Wed Ap 19 15.07.11 2017

# Tocl;
Symthesis

W simuiate
+2) Configure Flash Freeze
7] Corihigure Reguter Lok Bits
FiE Place and Route
4 b Vesify Post Lupout Tmplementad
=+ Gemerate Back Amnotated Fileg
W rntate
@, Varky Timing
@ Open SmarTime
K versy power
4 b A0 Ay
0 5 Anabyaer
b Proggam and Delug Dedgn
L) Generate FPGA, Auray Data
B Update 80 Memony Cortent
¥ Confipue Hardware

Connmitraty of

Sernlatien
Stimubus

Frogramming |
Idertify Debugger

Path
ety _debgoer ear

[#] [ 'i‘

Cr\MoosemiLbero_SoC v 11.8'dentfy'bniydentfy_debugper.exe

BB Configure Programmer

s Device 1O tates During Progy
& Configure Progmmming Cptions
@ Canfagure Securdy
4 b Program Design

[“Desionterse | St e

[ oo [rs ]| -

Configuration Report for MSS, SERDES(s), Fabric DDR
and Fabric CCC(s)

Microsemi Corporation - Microsem Libero Software Release v11.8 (Versson 11.3.0.26)

3. The created *.prj file by SynplifyPro/ldentify Instrumentor is opened in the Identify Debugger
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Power Matters.-

4. Setthe cable type as Microsemi_BuiltinJTAG as shown in the following figure.
Figure 18« Set Identify Debugger Profile within Libero

S Identify Dehlggerfi&l%ﬁﬁi%ﬂﬁ—ﬁh_ TL_syn =
Fle Edit Debug Options Window Help
= = R - =
=a|s¢ HEE -~ ¥ agR8E T B=
Conolea Cotintar Mot [avenis =] Vel ‘ 3| Sample Mode: [nomal - | roae et e disabled - ‘@
(& E LED Tooge ATL s = e T
63 other Fun s
& veres Cabe type: [Wicrosemi Bultnd TAG -
i sinthesis |
™ IcE Patsstings. | Showchan . |
Comm check
stiumentation sstting
Device famy SmantFusion?
Communicationport buitin
Skew Free: o
L _l_I
EY LED Toggle RTL sy | (T3IICE |
5:/Identify UG/synthesisé iice current IICE =]
INFO: iice current IICE
IICE
INFO: com cabletype
i

S:/Identify UG/synthesis§ S:/Identify UG/synthesis§

=

LED_Toggle.v
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Iicrosemi

Power Matters.”

5. Click the Run button. The Identify debugger stops when a trigger condition occurs and displays the
signal values in the GTKWaveform Viewer as shown in the following figure.

Figure 19 « Identify Debugger

[oession Flow #x Frperts &% Stwifage §% | Moo § % L

we ’ FoNP_ Wn. .- SR re— 1. — T R — .
=1 bugger - [ ity inftop myn'] =@ 8 ]}

& Conlagure MSS

B Creste SmariDesign{ | B | ¥ & Eﬁa Cyele |u

BT AODT [kl

i & 0SC_0op 0%5C_0_OSCH

B Floorplan to
b g

v yets -
B Senutate W) T - CEe T — R
W g Compie L i o ——
+71 Configuee Fushfref| | Fie Edt Search Time Markers View help |
| o GO EARC S sl | Fomfoe To:f2560 ne Y | Marker: 1240 n5 | Curser: 28 ns 1
=55 Vet
I :|
|
i 5l
Fiter: l
| Acpend| meert | maptoce %) s |
£0_Tegew ||

Note: For using different features and options within the Identify Instrumentor and Debugger tool, see
Synopsys ldentify ME Tutorial.
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